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Copyright © 1998 Bay Networks, Inc.
All rights reserved. Printed in the USA. June 1998.

The information in this document is subject to change without notice. The statements, 
configurations, technical data, and recommendations in this document are believed to be ac
and reliable, but are presented without express or implied warranty. Users must take full 
responsibility for their applications of any products specified in this document. The informat
in this document is proprietary to Bay Networks, Inc. 

The software described in this document is furnished under a license agreement and may o
used in accordance with the terms of that license. A summary of the Software License is incl
in this document.

Trademarks
AN, BCN, BLN, BN, and Bay Networks are registered trademarks and ASN, BayRS, and th
Bay Networks logo are trademarks of Bay Networks, Inc.

Microsoft, MS, MS-DOS, Win32, Windows, and Windows NT are registered trademarks of 
Microsoft Corporation.

All other trademarks and registered trademarks are the property of their respective owners.

Restricted Rights Legend
Use, duplication, or disclosure by the United States Government is subject to restrictions as
forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software claus
DFARS 252.227-7013.

Notwithstanding any other license agreement that may pertain to, or accompany the deliver
this computer software, the rights of the United States Government regarding its use, 
reproduction, and disclosure are as set forth in the Commercial Computer Software-Restric
Rights clause at FAR 52.227-19.
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Statement of Conditions
In the interest of improving internal design, operational function, and/or reliability, Bay 
Networks, Inc. reserves the right to make changes to the products described in this docume
without notice.

Bay Networks, Inc. does not assume any liability that may occur due to the use or applicatio
the product(s) or circuit layout(s) described herein.

Portions of the code in this software product may be Copyright © 1988, Regents of the 
University of California. All rights reserved. Redistribution and use in source and binary form
of such portions are permitted, provided that the above copyright notice and this paragraph
duplicated in all such forms and that any documentation, advertising materials, and other 
materials related to such distribution and use acknowledge that such portions of the softwa
were developed by the University of California, Berkeley. The name of the University may no
used to endorse or promote products derived from such portions of the software without sp
prior written permission.

SUCH PORTIONS OF THE SOFTWARE ARE PROVIDED “AS IS” AND WITHOUT ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.

In addition, the program and information contained herein are licensed only pursuant to a lic
agreement that contains restrictions on use and disclosure (that may incorporate by referen
certain limitations and notices imposed by third parties).

Bay Networks, Inc. Software License Agreement
NOTICE:  Please carefully read this license agreement before copying or using the 
accompanying software or installing the hardware unit with pre-enabled software (each of w
is referred to as “Software” in this Agreement). BY COPYING OR USING THE SOFTWARE
YOU ACCEPT ALL OF THE TERMS AND CONDITIONS OF THIS LICENSE 
AGREEMENT. THE TERMS EXPRESSED IN THIS AGREEMENT ARE THE ONLY 
iii
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TERMS UNDER WHICH BAY NETWORKS WILL PERMIT YOU TO USE THE 
SOFTWARE. If you do not accept these terms and conditions, return the product, unused a
the original shipping container, within 30 days of purchase to obtain a credit for the full purch
price.

1. License Grant. Bay Networks, Inc. (“Bay Networks”) grants the end user of the Software 
(“Licensee”) a personal, nonexclusive, nontransferable license: a) to use the Software eithe
single computer or, if applicable, on a single authorized device identified by host ID, for whic
was originally acquired; b) to copy the Software solely for backup purposes in support of 
authorized use of the Software; and c) to use and copy the associated user manual solely i
support of authorized use of the Software by Licensee. This license applies to the Software
and does not extend to Bay Networks Agent software or other Bay Networks software prod
Bay Networks Agent software or other Bay Networks software products are licensed for use
under the terms of the applicable Bay Networks, Inc. Software License Agreement that 
accompanies such software and upon payment by the end user of the applicable license fe
such software. 

2. Restrictions on use; reservation of rights. The Software and user manuals are protected 
under copyright laws. Bay Networks and/or its licensors retain all title and ownership in both
Software and user manuals, including any revisions made by Bay Networks or its licensors.
copyright notice must be reproduced and included with any copy of any portion of the Softw
or user manuals. Licensee may not modify, translate, decompile, disassemble, use for any 
competitive analysis, reverse engineer, distribute, or create derivative works from the Softwa
user manuals or any copy, in whole or in part. Except as expressly provided in this Agreem
Licensee may not copy or transfer the Software or user manuals, in whole or in part. The 
Software and user manuals embody Bay Networks’ and its licensors’ confidential and 
proprietary intellectual property. Licensee shall not sublicense, assign, or otherwise disclos
any third party the Software, or any information about the operation, design, performance, o
implementation of the Software and user manuals that is confidential to Bay Networks and 
licensors; however, Licensee may grant permission to its consultants, subcontractors, and a
to use the Software at Licensee’s facility, provided they have agreed to use the Software on
accordance with the terms of this license.
iv
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3. Limited warranty.  Bay Networks warrants each item of Software, as delivered by Bay 
Networks and properly installed and operated on Bay Networks hardware or other equipme
is originally licensed for, to function substantially as described in its accompanying user ma
during its warranty period, which begins on the date Software is first shipped to Licensee. If
item of Software fails to so function during its warranty period, as the sole remedy Bay Netw
will at its discretion provide a suitable fix, patch, or workaround for the problem that may be
included in a future Software release. Bay Networks further warrants to Licensee that the m
on which the Software is provided will be free from defects in materials and workmanship un
normal use for a period of 90 days from the date Software is first shipped to Licensee. Bay 
Networks will replace defective media at no charge if it is returned to Bay Networks during t
warranty period along with proof of the date of shipment. This warranty does not apply if the
media has been damaged as a result of accident, misuse, or abuse. The Licensee assume
responsibility for selection of the Software to achieve Licensee’s intended results and for th
installation, use, and results obtained from the Software. Bay Networks does not warrant a)
the functions contained in the software will meet the Licensee’s requirements, b) that the 
Software will operate in the hardware or software combinations that the Licensee may sele
that the operation of the Software will be uninterrupted or error free, or d) that all defects in
operation of the Software will be corrected. Bay Networks is not obligated to remedy any 
Software defect that cannot be reproduced with the latest Software release. These warrant
not apply to the Software if it has been (i) altered, except by Bay Networks or in accordance
its instructions; (ii) used in conjunction with another vendor’s product, resulting in the defect
(iii) damaged by improper environment, abuse, misuse, accident, or negligence. THE 
FOREGOING WARRANTIES AND LIMITATIONS ARE EXCLUSIVE REMEDIES AND 
ARE IN LIEU OF ALL OTHER WARRANTIES EXPRESS OR IMPLIED, INCLUDING 
WITHOUT LIMITATION ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR 
A PARTICULAR PURPOSE. Licensee is responsible for the security of its own data and 
information and for maintaining adequate procedures apart from the Software to reconstruc
or altered files, data, or programs.

4. Limitation of liability.  IN NO EVENT WILL BAY NETWORKS OR ITS LICENSORS BE 
LIABLE FOR ANY COST OF SUBSTITUTE PROCUREMENT; SPECIAL, INDIRECT, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES; OR ANY DAMAGES RESULTING 
FROM INACCURATE OR LOST DATA OR LOSS OF USE OR PROFITS ARISING OUT OF
OR IN CONNECTION WITH THE PERFORMANCE OF THE SOFTWARE, EVEN IF BAY 
v
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NETWORKS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO 
EVENT SHALL THE LIABILITY OF BAY NETWORKS RELATING TO THE SOFTWARE 
OR THIS AGREEMENT EXCEED THE PRICE PAID TO BAY NETWORKS FOR THE 
SOFTWARE LICENSE.

5. Government Licensees. This provision applies to all Software and documentation acquired
directly or indirectly by or on behalf of the United States Government. The Software and 
documentation are commercial products, licensed on the open market at market prices, and
developed entirely at private expense and without the use of any U.S. Government funds. T
license to the U.S. Government is granted only with restricted rights, and use, duplication, o
disclosure by the U.S. Government is subject to the restrictions set forth in subparagraph (c
of the Commercial Computer Software––Restricted Rights clause of FAR 52.227-19 and th
limitations set out in this license for civilian agencies, and subparagraph (c)(1)(ii) of the Rig
in Technical Data and Computer Software clause of DFARS 252.227-7013, for agencies of 
Department of Defense or their successors, whichever is applicable.

6. Use of Software in the European Community. This provision applies to all Software 
acquired for use within the European Community. If Licensee uses the Software within a cou
in the European Community, the Software Directive enacted by the Council of European 
Communities Directive dated 14 May, 1991, will apply to the examination of the Software to
facilitate interoperability. Licensee agrees to notify Bay Networks of any such intended 
examination of the Software and may procure support and assistance from Bay Networks.

7. Term and termination. This license is effective until terminated; however, all of the 
restrictions with respect to Bay Networks’ copyright in the Software and user manuals will ce
being effective at the date of expiration of the Bay Networks copyright; those restrictions rela
to use and disclosure of Bay Networks’ confidential information shall continue in effect. 
Licensee may terminate this license at any time. The license will automatically terminate if 
Licensee fails to comply with any of the terms and conditions of the license. Upon terminati
for any reason, Licensee will immediately destroy or return to Bay Networks the Software, u
manuals, and all copies. Bay Networks is not liable to Licensee for damages in any form so
by reason of the termination of this license.
vi
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8. Export and Re-export. Licensee agrees not to export, directly or indirectly, the Software o
related technical data or information without first obtaining any required export licenses or o
governmental approvals. Without limiting the foregoing, Licensee, on behalf of itself and its 
subsidiaries and affiliates, agrees that it will not, without first obtaining all export licenses an
approvals required by the U.S. Government: (i) export, re-export, transfer, or divert any suc
Software or technical data, or any direct product thereof, to any country to which such expor
re-exports are restricted or embargoed under United States export control laws and regulat
or to any national or resident of such restricted or embargoed countries; or (ii) provide the 
Software or related technical data or information to any military end user or for any military 
use, including the design, development, or production of any chemical, nuclear, or biologica
weapons.

9. General. If any provision of this Agreement is held to be invalid or unenforceable by a cou
of competent jurisdiction, the remainder of the provisions of this Agreement shall remain in 
force and effect. This Agreement will be governed by the laws of the state of California.

Should you have any questions concerning this Agreement, contact Bay Networks, Inc., 44
Great America Parkway, P.O. Box 58185, Santa Clara, California 95054-8185.

LICENSEE ACKNOWLEDGES THAT LICENSEE HAS READ THIS AGREEMENT, 
UNDERSTANDS IT, AND AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS. 
LICENSEE FURTHER AGREES THAT THIS AGREEMENT IS THE ENTIRE AND 
EXCLUSIVE AGREEMENT BETWEEN BAY NETWORKS AND LICENSEE, WHICH 
SUPERSEDES ALL PRIOR ORAL AND WRITTEN AGREEMENTS AND 
COMMUNICATIONS BETWEEN THE PARTIES PERTAINING TO THE SUBJECT 
MATTER OF THIS AGREEMENT. NO DIFFERENT OR ADDITIONAL TERMS WILL BE 
ENFORCEABLE AGAINST BAY NETWORKS UNLESS BAY NETWORKS GIVES ITS 
EXPRESS WRITTEN CONSENT, INCLUDING AN EXPRESS WAIVER OF THE TERMS 
OF THIS AGREEMENT.
vii





 

BayRS and Site Manager Software Installation

This guide describes how to install BayRS™ (router software) and Site
Manager software from CD.
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Before You Begin

Review this section before using the CD to install, upgrade, or modify 
router software.

Installing New Routers and Software

If you received this CD with a new router, you can use the instructions 
this guide to install Site Manager from the CD. (BayRS is already instal
on your router.) But first you must:

• Install the router as described in its installation guide. 

• Create your first network connection with the Quick-Start procedure

See Quick-Starting Routers for the Quick-Start procedure and full Site 
Manager system requirements and installation instructions. You should
familiar with the full instructions before using the summary in this guide

Upgrading and Modifying Router Software

If you received this CD as part of an upgrade, you can use the instructi
in this guide to install BayRS and Site Manager software from the CD. B
first you must review the upgrade section of the BayRS Version 12.20 
Document Change Notice.

If you need to reinstall or modify router software, you should review 
Configuring and Managing Routers with Site Manager before using this 
guide.
2



Command Summary

Use the following command summary only after you read this guide:

Mounting a CD-ROM Drive (UNIX Only)

SunOS: mount -r -t hsfs /dev/ sr0 /cdrom
Solaris: If the CD does not mount automatically, see page 6.
HP-UX 10.X: mount -r -o ro -t cdfs /dev/dsk/ c0t2d0 /cdrom
AIX: mount -o ro -v cdrfs /dev/ cd0 /cdrom

Installing Site Manager Software

For PCs, enter <CDROM drive> :\ms_win\setup.exe  in the Run window.

For UNIX workstations:
1. Enter cd /cdrom (cd /cdrom/release_1220_620 if automatically 

mounted).
2. Enter the command to install Site Manager software:

./install.sh  for SPARCstations

./install.sh  for IBM workstations

./“INSTALL.SH;1”  for HP 9000 workstations
3. Add the environment variables to each user’s .cshrc 

or .profile file.
4. Log off and log on again as the user.
5. Enter wfchkinst  and wfchkenv  to verify the installation.
3



Loading Router Software onto Your Workstation

For PCs, copy the router files in the rtr_1220 directory to a destination 
folder on your PC.

For UNIX workstations:
• On a SPARCstation, enter: ./copy.sh

• On an IBM workstation, enter: ./copy.sh

• On an HP 9000 workstation, enter: ./COPY.SH\;1

Unmounting a CD-ROM Drive (UNIX Only)

cd /
umount /cdrom 
(eject cdrom if automatically mounted)
4
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Mounting a CD-ROM Drive (UNIX Only)

The command for mounting the CD-ROM drive varies depending on the
requirements of the system. If the suggested mount command fails, con
your operating system documentation.

To mount a CD-ROM drive:

1. Insert the appropriate CD and drive tray into the CD-ROM drive.

2. Log in as root by entering:

su 

3. At the password prompt, enter your root password.

4. If a subdirectory or file system does not already exist for the CD, 
create one by entering the following command:

• For SunOS or HP-UX, enter:
mkdir /cdrom

• For AIX, enter:
crfs -v cdrfs -p ro -d’cd0’ -m /cdrom -A’no’ -t’no’
5



5. Mount the CD-ROM drive: 

• For SunOS, enter:
mount -r -t hsfs /dev/ sr0 /cdrom

sr0 is the CD-ROM drive’s address.

• For Solaris, the Volume Manager automatically mounts the CD 
onto /cdrom/release_1220_620. If the CD does not automatically 
mount, stop the vold daemon and manually mount the drive. 

a. Display the daemon’s process ID by entering:

ps -ef | grep vold

b. If there is a process running for the vold daemon, enter:

kill <process_id>

c. If a subdirectory does not already exist for the CD, create 
one by entering:

mkdir /cdrom

d. Mount the CD-ROM drive by entering:

mount -F hsfs -o ro /dev/dsk/ c0t6d0s0 /cdrom

c0t6d0s0 is the CD-ROM drive’s address.
6



• For HP-UX 10.X, enter:
mount -r -o ro -t cdfs /dev/dsk/ c0t2d0 /cdrom

c0t2d0 is the CD-ROM drive’s address.

• For AIX, enter:
mount -o ro -v cdrfs /dev/ cd0 /cdrom

cd0 is the CD-ROM drive’s address.

Installing Site Manager

This section describes how to install Site Manager from the CD in the 
following sections:

• Supported Workstations

• Installing Site Manager on a PC

• Installing Site Manager on a UNIX Workstation

For the system requirements and full installation instructions before 
proceeding, see Quick-Starting Routers.

If you are upgrading Site Manager, see the upgrade section of the BayRS 
Version 12.20 Document Change Notice before proceeding.
7



If you are installing a new version of Site Manager, be aware that the 
installation will overwrite the c:\windows\siteman.ini file. If you plan to 
run multiple versions of Site Manager, copy the existing siteman.ini file 
under a new name, then edit the newly installed siteman.ini file with the 
information from the previous versions.

Supported Workstations

Site Manager software runs on the following workstations:

• 486 PC (Pentium PC recommended)

• Solaris 2.5

• Sun UltraSPARC 30

• Sun SPARCstation 5, 10, or 20

• HP 9000 workstation Series 700 or 800

• IBM RS/6000 340, 370 workstation

• IBM PowerPC 601- or 604-based system

See Quick-Starting Routers for other system requirements.
8
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Installing Site Manager on a PC

To install Site Manager software on a PC running Windows® 95 
or Windows NT®:

1. If you are reinstalling Site Manager, delete existing Site Manager 
state files, which are created for all Site Manager tools you use. In 
the Run window, enter:

del c:\wf\*.sts

2. Insert the Site Manager CD into your CD-ROM drive.

3. Access the Run window by choosing Run from the Start menu.

4. Type the CD-ROM drive, path, and executable file:

<CDROM drive> :\ms_win\setup.exe

Drive D is usually the CD-ROM drive. 

Alternatively, you can use the Browse button, Windows Explorer, or
My Computer to select the CD-ROM drive and the path to the ms_win 
directory and then click on setup.exe.

5. Click on OK.

For Windows NT only, if the TCP/IP services file is not located in th
default directory (C:\WINNT\system32\drivers\etc), the installation 
script prompts you for the directory.
9
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The installation script then prompts you for the directory in which yo
want to install Site Manager. 

6. Enter the name of the directory where you want to install Site 
Manager, or accept the default, c:\wf.

The Site Manager files are installed in the chosen directory. When t
installation is finished, the following prompt appears:

Create Windows program group/items automatically?

7. To add Site Manager as a selection on the Start > Programs menu,
click on Yes.

This option allows you to start Site Manager after installation by 
choosing Start > Programs > Site Manager > PC_Site Manager.

The following prompt appears:

Do you want to start Site Manager now?

8. Click on Yes to start Site Manager.

The Router Connection Options window opens.

9. Enter the IP address of the initial router interface and the router’s 
SNMP community that you created during the 
Quick-Start procedure.

10. Click on OK to display the main Site Manager window.

After you successfully install and start Site Manager, see Configuring 
and Managing Routers with Site Manager for more information.
10



Installing Site Manager on a UNIX Workstation

To install Site Manager software:

1. Review system requirements.

2. If you are reinstalling Site Manager, delete existing Site Manager 
state files, which are created for all Site Manager tools you use. 

To delete the Site Manager state files:

a. Log on as the root user by entering:

su

b. Enter the following command from the home directory of every 
user account:

rm <home_directory>/.wf*

3. Mount the CD-ROM drive. 

See “Mounting a CD-ROM Drive (UNIX Only)” on page 5 for 
instructions.

4. Edit the workstation’s /etc/services file to add the following lines at 
the end of the file:

snmp 161/udp

snmp-trap 162/udp
11



5. As root, change to the CD-ROM mountpoint.

cd /cdrom

If you use Solaris and are running the vold daemon, enter:

cd /cdrom/release_1220_620

6. Run the script to load Site Manager software by entering the 
following command:

• For Sun SPARCstations, enter:
./install.sh

• For IBM workstations, enter:
./install.sh

• For HP 9000 workstations, enter:
./“INSTALL.SH;1”

When the installation is finished, your workstation displays the 
message:

Site Manager Installation Complete.

Additional messages about your SPARCstation environment may 
appear.

7. For new installations, create the builder directory by entering:

mkdir $HOME/.builder_dir
12
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8. For each user, edit the shell environment (see Quick-Starting 
Routers). 

For example, on a SPARCstation with the C shell (csh), add the 
following lines to .cshrc:

set path = ($path /usr/wf/bin)

setenv WF_SMPATH /usr/wf

setenv SMTERM X

setenv SM_CONFIGS <config file directory> 

setenv BUILDER_DIR $HOME/.builder_dir

9. Log off and log on again as the user.

10. Verify the Site Manager installation by entering:

wfchkinst

11. Verify the Site Manager environment for each user account by 
entering:

wfchkenv

12. Start Site Manager by entering:

wfsm -a <router_IP_address> & 

<router_IP_address> is the IP address of the router’s initial interface
13
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Installing BayRS

If you need to upgrade, modify, or reinstall router software, read the tas
in the following sections:

• Loading Router Software onto a PC

• Loading Router Software onto a UNIX Workstation

• Continuing the Router Software Installation

Before you begin the installation, complete the preinstallation tasks for 
your system. For upgrades, see the upgrade section of the BayRS Version 
12.20 Document Change Notice. For general information about the Image
Builder and transferring router images to the router, see Configuring and 
Managing Routers with Site Manager.

Loading Router Software onto a PC

To load router software onto a PC running Windows 95 or Windows NT

1. Insert the CD into the CD-ROM drive.

2. Choose Start > Programs > Windows Explorer. 

The Windows Explorer window opens.

3. In the Windows Explorer window, click on the CD-ROM drive icon 
(for example, drive D).
14
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4. Click on the rtr_xxxx directory, where xxxx is the router software 
version.

For example, for BayRS Version 12.20, click on the rtr_1220 directory.

You see a list of directories specific to the version of router software
you are using, such as an, asn, bn, and so forth.

5. Click on the directory for your router platform.

6. Copy the router files in the platform directory to a destination 
folder on your workstation. 

For example, one method you can use to copy the router files to a 
destination folder is as follows:

a. Hold down the Shift key and click on each file you want to copy. 
The files are highlighted.

b. Choose Edit > Copy.

c. Click on the folder to which you want to copy the router files.

d. Choose Edit > Paste.

The system copies the router files you selected to the destination fo
on your PC.
15



Loading Router Software onto a UNIX Workstation

To load router software onto a UNIX workstation:

1. Insert the CD into the CD-ROM drive.

2. Mount the CD-ROM drive. See “Mounting a CD-ROM Drive 
(UNIX Only)” on page 5 for instructions.

3. Change directories by entering:

cd /cdrom

4. Run the script to load the router software using one of the 
following commands:

• On a SPARCstation, enter:
./copy.sh

• On an IBM workstation, enter:
./copy.sh

• On an HP 9000 workstation, enter:
./COPY.SH\;1
16
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During the load procedure, you must specify the following:

• The directory where you want to load the router software, for 
example, /usr/wf/rtr_1220

• The router platform
The system then loads the software for the platform you selected.

Continuing the Router Software Installation

If you are installing BayRS as part of an upgrade, see Upgrading Routers 
from Version 7-11.xx to Version 12.00 to complete the following upgrade 
tasks:

1. Load the router software into the Image Builder.

a. Go to the directory where the router software image files 
reside.

b. Double-click on the directory that contains the router software 
image you want to load. 

c. Choose the file name of the router software image that you 
want to load, for example, bn.exe. 

d. Click on OK.

After you choose the directory and file name of the image, the Imag
Builder window lists the current components of the router software 
image.
17
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2. Modify the router software image.

You modify the software image to:

• Remove any nonessential files (protocols) that you will not use t
save space on the flash card.

• Add new components (protocols) as you need them. 

See Configuring and Managing Routers with Site Manager for detailed 
instructions on removing and adding software components to a rou
software image.

3. Save the router software image by choosing File > Save.

Bay Networks® recommends that you save modified software image
in a different directory, and that you use different image names for e
router on your network.

4. Prepare the router to receive the new software image.

Before you can transfer a customized image to the router you want
upgrade, you must first prepare the router’s flash card or flash SIMM
receive a customized image and a configuration file. 
18
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5. Transfer the customized image and router files to the router.

You can use the Router Files Manager to transfer a customized 
software image and associated router files to the router you want to
upgrade using the Trivial File Transfer Protocol (TFTP) command.

6. Upgrade and verify PROMs on the router.

The router’s programmable read-only memory (PROM) contains 
software images for its bootstrap and diagnostic code. Bootstrap an
diagnostic PROM code is included on the BayRS Version 12.20 rele
media. 

Bay Networks strongly recommends that you upgrade PROMs in a 
router to implement the latest software or hardware features before
booting with a new version of router software.

7. Boot the router with the customized image.

After you successfully transfer the customized image to the router a
upgrade the PROMs, you can boot the router with the customized 
image. The first time you successfully boot an ASN™ router from a 
Version 12.20 image, the boot time may be longer. After that, you c
shorten the boot interval by changing the default Netboot settings. 

8. Upgrade the existing configuration file.

You need to upgrade your existing configuration files to support the
new Version 12.20 features. Optionally, you can create a new Versio
12.20 configuration file to replace your existing configuration file for
the router.
19
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You upgrade your existing configuration file using the Configuration
Manager by booting the router with the current configuration file 
(config) and saving it in dynamic mode. This updates the configurati
file’s version stamp to match Version 12.20 router software. 

See the BayRS Version 12.20 Document Change Notice and Upgrading 
Routers from Version 7-11.xx to Version 12.00 for the remaining 
upgrade tasks.

Unmounting the CD-ROM Drive (UNIX Only)

To unmount a CD-ROM drive, enter:

cd /

umount /cdrom 

For CDs automatically mounted on a CD-ROM drive, enter:

cd /

eject cdrom 
20
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